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U1 R & Yageo JSEARE NG B AFHAGRSE, #208 0201 b A rE BRI RHRST HERER)
PCB % 51 /20.35mm*0.25mm, E#HIFEE I 0.2mm~0.3mm
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COMNSTRUETION

The resistors are constructed out of a high-grade ceramic OUTLINES
body. Internal metal electrodes are added ar each end and
connected by a resistive layer. The resistive layer is adjusted For dimension se= Table

to give the approximate required resistance and laser cutting
of this resistive layer that achieves tolerance trims the value.

The resistive layer is covered with a protective coat and

printed with the resistance value. Finally, the two external
terminations (matee tin) are added. See fig. 5.

DIMEMSION
—Table | For cutlines see fig 5

TYPE

L {mm)

Wimm) H (mm) | (mm)

l2 {mm)

marking kyar
prodeciive Coal

resistive layer

e electade

VarFinalion (M matts ik

\—wulm’;uuhﬂhale

REO201

040 +003

0304003 023 +003 010005

(.15 £005

REO402
REO803
REOB05
REI206

100 £005
160 010
2001010
310010

050005 032+005 0204010
080 £0.10 0452000 0252015
125010 050010 035 020
160 £0.10 0552010 045 +020

025 +0.10
025 +0.15
035 +020 .
040 £020

k. AL

SR

—Fig. 5 Chip resistor outlines

355 R <) 0.35%0.25mm, &4 AEE 0.2mm RZES7 PCB £ %4,

1. 4TJF PADS Layout ¥, %% Tools—PCB Decal Editor, 3k 35535 4 4 8%

JEC:\FADS Projectsidefanlt pch — FADS Layout

File Edit Wiew Setup

= & | |HTop

Tools | Help

PCE Decal Editor 1=

2. File->New Decal, #rahf:

3. #iili Drafting Toolbar T. E.#*

Cluster Placement...

:| File | Edit Eiewi%;bup Tools

| New Decal Ctri=N

E-F’ Dpen Decal... i+
H Save Decal Ctrl+5

Save Decal As...

Sawve As Start-up File...

Library...

Exit Decal Editor

,_r;’]]et:al: Hew — FADS Layout

File Edit View

Setup

Tools  Help /

@ [ Top

= @ e | <

oMb ZZ 2 MHEULERT




4. 15l Terminal->i%#% Surface Mount—OK, K NG BHZEFRNGH, FrolEik$

Surface Mount

! File Edit View Setup Tools Help
& |l [[t70p M= <= 1=Xs
BEIREEZ A E o2
Projer ¢ Explorer

(R T 4dd Terminals

Compoz
FCE D

LY
£if Hets

~Pin Type
" Through Hole
& surface Mount

—Start pin number
Prefix: Suffix

! E

Fin numbers: 12 3...

Increment options
Step value:
" Increment prefix

% Increment suffix I 1 ﬂ

[ verify valid JEDEC pin numbering

f,--' K, I Cancel |

5. 192U, FIAHRGEES UMM, ¥ PCB B4/ 008 mm, — AR Z L mm A AL
ERVESE S

Name

6. M7 PAD—Alt+Enter— &t Pad stack, i AR ~F¥&E AR

9 Terninal Froperties WISIEY
X: oK
Y: Jo.3 Apply
Fin Mo: I 1 Cancel

’ Help
§

Pad stack ™| associated copper

ey
n
G
s

L

&




7. i Mounted Side— i 7457 PAD—>K 58 5 B N 0.35mm A1 0.25mm; AR
NE#sfF, FrLh Inner F1 Opposite #4& 0, R, HAHAN O

.T.;’l"ad Stack Froperties for Fin

P'"Nm Plated: e 0K,
i nted Side

SNN 0 =Inner Laers:b
SMM 0 <Opposite Side =

Cancel

T

Add Copy
Delete Baste
Assign to all selected pins [ Preview:

—Parameters
Use Global Befaulks eJ
Pad style:
Pad |Therma|| Antipad

eHmO ¢

[ Pad size relative to drill size

Slot Parameters
- [T Slotted
Width: Length: :
|_|_2. c :I |_3' - i’ Length: III- :I
Orientation: Offset: Orientation: |.00 :I
|_|:|.|:u:u:| :I |.:, :I Offset: |.;. :I
Corner type: Radius:

[s0Degrees 7| [0 = || oa size: [0 |V pated

&

8. ¥NIIl Paste Mask Top /=, RSG5 7 U570k, KKFEEEN 0.35mm 1 0.25mm



JAPad Stack P x|
Fin Mo: Plated: Sh. Sz. Layer: ok |
RNM 2.5 <Mounted Side =
SMM 0 <Inner Layers:> |
SNM 0 <Oppgsite Side > Apply
/é Cancel |
ad | o
Ml rdd Layel x| = o) Help |
Layer:

Delete Paste

Assign to all selected pins [~ Preview:

i

— Parameters
Ise Glofal Defaulks |
Pad style:
Pad |Therma|| Antipad |

oemoOe¢n"?

[~ Pad size relative to drill size

Slot Parameters
) [ Slotted
Width: Length: :
I_Z. z :I |_3. - :I Length: IE- j
Orientaton: Offset: Orientation: |0.00 j
[o.000 = o - Offset:
Corner type: Radius:

IEII:I Degrees j |':' :’ Crill size: ||:| i’l? Flated

2

9. LML 8 U7 VA VNN Solder Mask Top /2 (5 IFIANEE ST Solder Mask Top, 1E#
[P — AR @S , K% LLLK Paste Mask K 0.05mm



ﬂl"ad Stack Froperties for Fin EI
Pin Mo: Plated: Sh. 5z. Layer: -
-DK
SNN 0 <Inner Layers> a |
_reoy_|

SNN 0 <Opposite Side >

RMM 0.3 Solder Mask Ta

RMM 0,25 Paste MaskTE Cancel |
Add Copy Help |

Delete Paste

Assign to all selected pins [~ Preview:

—Parameters
se Global Defaults | _|_

Pad style:
Pad |Therma| | Antipad I

OO ?

[~ Pad size relative to drill size

~ Slot Parameters
i [T Slotted

Width: Length:

ID' 3 :I Ir ill Length: I ] j
Dricnitzbion: Offect. - | orientation: [0.000 :I
Wj In—ﬁ Dffset: I— :I
Corner type: Radius:
JsoDegrees =] 5 | ori s o =W Plated

&

2

N

N

10, 2T RS RSFH) PAD, BUONHIFHA PIAS PAD, W E

11. Ctrl+Alt+C HREEFE 4, ¥ Solder Mask Top FJERICH], X5 HUTH



{5

— Selected Colar Polcitc |
LI 0 0 ioieim indml | Inim =
CFEEEFEERERCECrCFECE Default Palette | Assign Al |
-l
Layers/Object Types # § =HE =B
a Jdlelgl = T
& Q86| = = E |2
Visible Only I [# V¥l W |l =l v
19 Layer_19 3 ESES # % N
20 Layer 20 g e I}{}{ AR
21 Solder Mask Top 4~ Ly TR OMOW MMM KM W KWW KX
22 Paste Mask Bottom /” ™ WM , Wi WK
23 Paste Mask Top W Wi W Hix J
24 Drill Drawing Il x « W
25 Layer_25 Miowix P K WX
26 Silkscreen Top ~ Il WM X b

12. Ctrl+C E#I%5ME— PAD2— PAD1 1 PAD2 [FII %3¢, i Crt+L-fidy 1 8
2 #RRT LA, AT AN SF

13. W& PAD1 #1 PAD2 fJ[aJ#E, PAD HJ%:/% /& 0.25mm, APl PAD1 Al PAD2 HJZ\
AAFEAE 20.25+2mm=0.45mm, 1 %% PAD1 1 PAD2 (I br— N B M -0.225,
— N EE A 0225, 1IEGFA 0.45mm

HEER:

o PAD FEINALFRERAZ IR 5 3] PAD HR0 S A PR 5 s
o FTH RSP B AL AUE T S NABFR IR B, AIRAUERS, H PAD1 A1 PAD2 Ak
B R 248 56 0 251 5 A1)




'I-'Terlinal Frope _IDIEI

s E oK |
Y: [0.25 Apply |
Pin Mo I 2 Cancel |

_teo |

Help
g

Pad stack ™ associated coppet

~lcix

(84

L

-

¥: 0.225 Apply

Fin Mo: | 1 Cancel

Help
g

Pad stack [T associated COpEEL

14. Setup-Set Origin, &E 5 s, W JESUHEEMA PAD IEHRE], RETEZ
JG, TREEEA PAD1 F PAD2 fJAeky, Fahdb 7%, iR e o E

Setup | Tools Help

Pin Mumbers...
Pad 5tacks...

Decal Rules...

Layer Definition...

Set Origin ~

Grid and Width...

Display Colors... Chrl=Alt=C
1 default




15, WINIAHELZED

ﬂ]]ecal: Hewx — FADS Layout

! File Edit View Setup Tools Help
=2 =N = | e 2 | | <2
[x|@ MY EZHETERE

Width... W<nn>}
Line Style 4
Layer... ik=nn=}
Auto Miter
Polygon _ HFY
Circle / {HC}
Rectangle THR}
Path HH}
Snap to Objecs {0s]
Snap to.. 4

16, R4 PAD 4 F| 22 ENHIEE RS A 0.15mm, #] DLEH 22 B AR AR, N AR bR
B, ENAEANGHERE

i
Type: 20 Line
First Comer: 0K
®1: | ¥1: |[:-.5 Anply
Second Comer:
X2 [0.325

Y- I-D.E- Cancel

dilie

Help

Start Angle: Delta Angle:
o o

Width: 0.00991

Length: 1
Layer: Top
Track Clearance: n/a
Met:
Met Parent

17, HEiEH 2D line—»>H4E+5 4 Alt+Enter—4% Layer % & /4 Silkscreen Top



_iEix

Type: IED Line j
~Line settings

width: [0.00991 Style: |Solid .
—Shape settings

Scale factor: I 1 Arc approximation error: IIII.IZI 127
Fotation: IEI.EIEIEI ™ solidicopper

Copper to trace dearance: nfa

Flaod & Hatch
options

Layer:
-

Met assignment
Tim assign & met, selech a mek in the list and click Sppli. .

| Oy

18. ¥ Type £ Name Jill & 7€ 7] B 7]

19. ¥ Geometry Height 1% & N#s 115 K& &




al - Hew* — FADS Layout

View Setup Tools Help
Undo Ctrl+Z |
L
Redo Ctrl+Y
S Cut Ctrl+X
Copy Ctrl+C
Copy As Bitmap...
BB Paste Ctrl+V
< Move Ctrl+E
?( Delete / < Delete=
 Attribute Manager...
Highlight Ctrl=H
Unhighlight Ctri=1
Select All Cirl+=A
ﬂ Cycle <Tab=
k- Filter... Ctrl+Alt=F
Properties... Alt+<Enters
JfDecal attributes: Hew = 0] x|
Value add |
: { 0.26mm
Delete
CAM Solder mask. Adjust /’
CAM Paste mask Adjust Edit |
ﬂmws&ljb.thr...l
Close Help |
e
20. {Rf7E %, File—Save Decal As
File | Edit ¥iew Setup Tools
New Decal Ctrl=N  §
E-q' Open Decal... Ctrl=0 L
I save Decal / Ctrl=5

Save As Start-up File...

Library...

Exit Decal Editar

21. B PCB Decal &k IHAR-AZH



JoSave PCE Decal to Library

X

-

Library:
IC:WentorGraphics\P.ﬁ.DSW{.z. 50D _HOME\Librariescommaon j

Mame of PCE Decal: IR-D2D1|
QK I Cancel |
o

£ ) T |
JfPart Information for Part — Unnamed ﬂ

General |PCB Decalsl Gates I Fins I Attributes I Conmector I Fin Mappingl
—Fart Statisties —Logic Family

2 o s =

Tecal: R-0z201

A et R

Fate 1

Signal Fin L Families. .. |
—Options

[ Define mapping of Part Type pin numbers to PCE De [~ Special Purpose

[v ECO Registered Pa {" Copmector

{"0ie Part
Prefi
I—” = {" Flip Chip
0K | Cancel | Save As. .. | Help |
A

22. & HE Parttype ZFRIF{RTE Part Type 2IFE CHEh, ZFREH Decal ZFE—E

JiSave Part Type to Library EI

Library:
IC:\,r'«"IentorGraphics\P.ﬁ.DS'l.-'}{.l. $500_HOMELibrariescomman ﬂ
Mame of Part Type: IF‘.—DZ[JI

e

QK I Cancel

2, #H57 0201 MG A FER PCB H I 5EH 1 -



8. PADS & if BOM

8.1 PADS Logic % { BOM

PADS Logic 7! BOM e NG TR Z 1), WS R RS, nf LA
logic 5t BOM, 052X, wims 2 H 10.2 K777k,

File | Edit View Setup Tools Help

Mew Ctri=MN
|
Dpen.. Ctrl= 0O

n Save Ctrl+5
Save As..
Import...
Export...
Create PDF...

Archive...

Library...

(::__Eepnrts... Ty
-

Plot...

Select Report Files for Output:
[7] Urused

[ | Part Statistics

[] Net Statistics

[ Limits
[] Connectivity

7] Bill of Materials (| Setup... |)

Copy Z & HAZE # 2] Excel H1EI ]


af://n383
af://n384

Attributes I Format {Clipboard Wiew |,

Otr ERefer... FPart Hame Marufacturer Desecription

] »

M TH

4

2 I$elect ﬁ.l:g [( Copy -j 3 [ Include table head

8.2 PADS Layout 5 { BOM

BB

1. Tools—Basic Scripts—Basic Scripts


af://n390

“Tools |} Help

—

PCE Decal Editor /'%,E SRR

Cluster Placement...

Cluster Manager...

Disperse Components

Length Minimization Ctrl+M

Mudge Components

E=] PADS Designer...
Analysis
Manufacturing
DFM Analysis

&l PADS Router..

(4 Import PartQuest Parts

Copper Plane Manager...
Assembly Variants...
Update from Library...

Verify Design...
Compare Test Points...
DET Audit...
Compare/ECO...

ZE  ECO Options...

Macros
_Basic Scripts » Basic Script Editor...
¢ Basic Scripts.y
Customize... —— = _p_____

2. MTHE—IKT BOM F/MAFE, @i A a0 F3k4T Script Wizard 1% &

| PADS Layout Seript Wizard

20 - Excel Drill Report

21 - BExcel Drill Drawing

22 - Bxcel Drill Drawing with Testpoints
23 - Create Assembly Labels

Alive Net List —
BGA Die Report Loaa Hie...

BGA Expo | Unload File |

Help

Part Report

Close

Description
C:APADS ProjectshSamplestScrpts®Layout \PADS Layout Script Wizard bas




Introduction

—

Welcome to the VB Script \Wizard.

Thiz program iz completely written in PADS Layout's WB zoript language. [t will
generate a skeleton VB zonpt for extracting databaze information in different
application formats including BTF, Excel, and HT kL.

The “Wizard conziztz of a maximum of 3 steps. Al zettingz you have made will be
zaved in the Windows Reaistry, 20 you can alwaps remn the Wizard and then tune
I| =ettingz uzing a previous repart as & preview.

After completing thiz Wizard, pou can extend the resulting VB scrpt by manually
wiiting additional code.

Mo you can easily put vour colared HTML reparts an the camparny's [ntranet or
Internet sites to share them with pour colleagues or custamers!

WB Script Destination Directary

CHPADS Projectsh\SampleshS crptshLavout

[

Cancel ]

Format

Chooze the target application format far the new VB script.

R ezulting%B code will vary depending on your choice.

(71 Natepad Flain text format. Fited width font recommended.
[Minirnurn formatting]

] (7 wWordPad A M5 Wword  Rich test format.

[Eetter formatting]

Microzoft Excel Spreadzheet.
[Better farmatting with tables]

) Internet Browser HT L format.
[Bezt output guality, with colored tables)

[ < Back




Report Type

Reparts will contain database items collected from the entire design.
Azzembly Option will not be taken into account,

(71 Assembly Option Repaorts

Part and jurnper information will be extracted for each azzembly option
indivudually.

") Reports far Given Aszembly Option

B azelption

Database Object

Pleaze choosze the type of databasze object that will be primary far the repart.

(71 Nets (") Connections
) Jumpers (71 Pinz (71 Boute Segments
i (71 Part Types 71 Yias (70 Test Paints

Calculate the total number of primany objects in the design




Data Types

Y'ou have chozen Part az the primary twpe of database object for the VB report. Mow
wou can chooze what data the new WEB script will extract from a Part,

=1:§-_I3 eneral Part properties in table fl:lrrgéi:}

Each row of the table representz an individual Part, and each column
representz a Part property, for example:

I Attnbutes, Part Type, PCB Decal, Logic Farmily, Pin Count.

(71 List[z) of secondary objects related to each Part

For example: All Fing, Connected Pine, Unconnected Pine, Attributes

() List of Part objects anly

Edit List...

[ < Back ][

3. HAdd iEHFHOHFESFHM NS, —MRPTED T : Name. PCB Decal.
Value. Part Type 1 Layer Name

Object Properties

Add Part properties ar attributes to the lizt of table columns.

Part Properties: |Ta|:u|e Calumnnsz:
Crigntation M arme

Logic Family FCE Decal
Pir Cont Walle
Power Fin Count Fart Type
Urzonnected Pin Count << Bemove Al M
Tolerance
| | Glued (res/Ma) T S[mE==t=n0
SKD [vesdMo]
ECO Registry [Yes/Ma) Derm
Laver Humber
Position = -
Pozition v

I . . .
Attribute [Select exizting or type any valid name):




-
Report Options

Select additional report optiong for the B script.

Output Feport Header

Part B eport

Header ncludes;

[¥] Job Mame

Output Indew ¢ T able of Contents [for HT ML reparts only]

Show report generation progress in: Status Bar [ | Progress Bar

[] Enable Text slignment far Table Columns

Date and Time Stamp

4. #iii Finish & Run Report Now

[ < Back [ Mewt >

]

-

Output Files

Fart Report

Select the name of the repart file to which the new VB Script will extract information.

(7 Always bazed on job name [narme of the schematic file will be uzed]

() Custam repart file narme [tope without file extenszion]:

File Estenzion:
wlz

@ Create new untitted document and pass data via Clipboard
Thiz option gravs if you chiose WordPad or Internet Broweser in step 2.
[Fecommended for Excel to avoid file share violations. ]

Fart Report

Enter the name of the rezulting 'WB zcnpt [without BAS extenzion]:

| <Back | Finish

)

[ Finizh & Bun Beport Mow J

B m] %t BOM SCAF, %t )R 2 2 BiRATTH Add R INET N 2%

9. PADS % SMT AL ¥R 3 14

9.1 F| FH CAM ¥ % H

BT

1. A File>CAM Plus
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Edit View Setup Tools Help
(0 Ctrl+N
= Ope, Ctrl+0

I save Ctrl+5
Save As...
Import...
Export... @
Create POF...

Archive...

Save as Start-up File...
Set Start-up File...

Library... @

Reports...
LCAM...

CAM Plus.. & ||

Print Setup...

2. Side ¢ TOP, RFE [T HE TOP M #4FI44FR, Parts &4 SMT, Output
Format i£4% Dynapert Promann, xiifiiz4T, TOP [MizfT < 5, Side Ffit$¥
Bottom, f}igiT—iX

Part Definition Filename:

Setup Geometmy

Side: Board Offzets
| Ta | @ #-Offzet; Y-Offzet;

p -
arts: u o
@ S

#-Count: -Count:
[ Read Part Definitions 1 i
Fiead ¥alue Attributes %.Shep: Y-Step:
[] erify File ] n

[| Batch Part Def. File

[EI Ltput Format; ] @

Dyrapert Pramatn

[riverzal Tooling: niversal dxial Qukput;
Groupl LiztFile

Status Meszages:

3. HiiHfE



Part D efinition Filename:

part. def

Help

Setup [Geometry
Side; Board Offzets
= - #-Offget; v-Offzet;

| PADS Layout

Status : Generating Dynapert Promann output

Diynapert Promann -

Iniversal Tooling: niversal Axial Output;
Groupd LiztFile

Statuz Meszages:
PartRf : TW5303

4 IRJE SN U AR bR SCPEFITAE (1 H 5%



Part D efinition Filename:
part. def Fun

Help
Setup [Eeometmy
Side: Board Offzets
(Tom - w-Oifzet: v-Offzet:

Ayout

no- File CAPADS Projects\Cam', . MIVDYNPROST.Z1E created

SO AE BB AE 9 E SR

| Dynapert Pramani

niversal Tooling: niverzal &xial Output;
Groupl LiztFile

Statuz Meszages:
PartRf : TWwS303

5. %M BRI H S, BB CH, FEE: AW, DYNPROSB #1 DYNPROST

&R | DYNPROSB - i85 ESRIER
camplus.rep B #EE B0 BBV #EH

7| D¥NPROSE 1 J204 Missing -1.474  14.774 90 -~

LZ0T Missing -9.013  14.423 270
[ (2] DYNPROST €220 Missing -9.170  15.200 0 =
C219 Missing -9.176 156842 0
J201 Missing =9.005  11.910 180
U201 Missing -13.484  11.916 Z70
CZ03 Missing -17.184  11.837 90
RZ01 Missing -17.802  11.8937 90
RZ0Z Missing -17.774 100888 90
CZ0Z2 Missing -17.174 100888 90
C631 Missing -20.036  11.834 270
R6d4l Missing -21.094  12.5B1 Z70
R640 Missing -21.704  12.551 90
RE39 Missing -23.130  12.531 90
RE38 Missing -23.734  12.531 90
RE0Z Missing -2b. 37T 1Z2.L64 270
Q601 Missing -26. 650  11.920 180
CB03 Missing —26. 658 9.943 180
U610 Missing -24.100 10,500 Z70
U611 Missing -20.839 100124 90
CE3Z2 Missing —-20.147 3.569 180
CE29 Missing -23. 293 3.749 490
CB28 Missing -23. 918 3. 745 90
CE30 Missing —2b. 626 8. 752 180
NIC301 Missing -35. 183 9. 675 270
TVS30Z Missing —35. 971 15,330 180
TVS301 Missing -34.171 15.330 0
C305 Missing -34. 871 14,180 180
C303 Missing —-3b. 821 14,180 180
FB301 Missing —3b. 771 15, 380 270 -
HE55: 2019/11/15 15:55 SIEREE( 385,530 61

CLE, FIH CAM Jift 075 20 tHARARSCAF R 5E Bl T




9.2 F F Basic Scripts % i

1. #ii Tools—Basic Scripts

Tools | Help

PCE Decal Editor

Cluster Placement...
Cluster Manager...
Disperse Components
Length Minimization

Hudge Components

DxDesigner...
Analysis
Manufacturing
EDMD Collaborator
PADS Router...

Archive Mavigator

Pour Manager...
Assembly Variants...
Update from Library...

Verify Design...
Compare Test Points...
DET Audit...
Compare/ECO...

ECO Options...

Macros

Ctrl+

Basic Scripts

Basic Script Editor...

2. Fiii 17-Excel Part List Report 5, 5t Run igfT

Customize...

Dptions...

Ctrl=<Enter=

EBasic 5cripts...
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17 - Excel Part List Report

10- Ligt Of Comps and Mets
11 - Select by Pin Count

12- Mqve by Fin Count

A T =k

S NEL LR

BGA Die Report Unlaad File
BGA Export Die to C5W File
BGA Wirebond Report
PADS Layaut Script 'wizard

Fart Report -
F - Cloze

Dezcrnption

C:APADS ProjectshS amples\ScriptzhLapouth17 - Excel Part List Report. BAS

m

3. BT BB T ALK T Excel #% 2 ARKR S

- ] ] =) W, e -
By *Z:j o - AT SiEmes A M B W Ea @ ;Zﬁw ﬁ}? o
EEY - — s N
s e B 7 U (&A% R Wy, o | op gy SRR BAWTERT A M BR g, HORDME @0RR
i & FE & N = N == L] B
mz - I v
A B c o 1 F G H I I E L n u 0 ;
1 PartType RefDes PartDecal Pins Layer Orient. X Y SED Glued
2 C-0201 clol C-nz01 2Bottom 180 11.237 22.563 Yes No E|
3 C-0201 clo2 C-0201 2Bottom 80 9.185 23 Tes No
4 CAP-0402 c103 0Q_0402C-1 2 Bottom 0 9.852 39.163 Tes HNo
5 CAP-0603 1058 0B03C-N 2 Bottom 0 9.811 38.131 Yes No
6 C-0201 ca201 C-0201 2Bottom 0 21.379 2B.71Yes Re
7 C-0201 can2 C-0201 2Bottom 90 17.174 10.988 Yes Ne
8 C-0201 Cz03 C-0201 2 Bottom 90 17.184 11.937 Tes Ho
5 C-0201 c204 C-0201 2 Bottom 180 14.716 156.98 Yes Ho
10 C-0z01 205 C-0201 Z2Botton 0 15.783 15.964 Yes Ne
11 C-0zol c20g C-nz01 2Bottom 180 14.72 16.578 Yes No
12 |c-0201 czoT C-0201 2 Bottom 0 15.785 1B.584 Tes HNo I .I
13 |Q_CAP-0803 cz208 Q_0B03C-1 2 Bottom 180 15 17.46 Yes Ne
14 CAP-0B0D c209 SMDOB0T 2Botton 90 17.432 16.817 Yes RNe
15 C-0z01 calo C-nz01 2Bottom 0 17.483 13.892Tes Ne
16 |C-0201 Ccz11 C-0201 2 Bottom 90  18.92 20.8 Yes  No
17 |C-0201 cz21z2 C-0201 2 Bottom 180 1B.77 21.6 ¥es Neo
18 |C-0201 c213 C-0201 2 Bottom 180 1B.74 23.175Y¥es Ho
19 C-0z01 cald C-nz01 2Bottom 90 12.345 16.183Tes Ne
20 C-0201 C215 C-0201 2Botton 80 19.57 20.8 ¥es Ne
21 |c-0201 CZ16 C-0201 2 Bottom 0 19.72 21.6 Yes  No
22 |C-0201 cz217 C-0201 2 Bottom 0 19.74 23.175Yes No
23 C-0z0l cais C-nz01 2Bottom 90 13.453 16.185¥es Ne
24 C-0201 c219 C-0201 2Bottom 0 9.176 13.642 Tes No
25 |C-0201 Czz20 C-0201 2 Bottom a 9.17 15.2 ¥es  Ne
26 |C-0201 czz21 C-0201 2 Bottom 270  B.88< 9.03 Yes No
27 C-0z01 ca222 C-nz01 2Bottom 180 8.19 10.283 Yes No -
1€ € » M| Sheetl ~Sheet2 Sheetd /70 [0KAl I a0
x| i Themiei(y)
- = — — ——

H ) NAE Basic Scripts Ft1H N KI%H 17-Excel Part List Report iX—i, FA17] LA
siir Load File, 2 HahBk#| PADS I3 H T, RATESES 17 B0, 145 Run

|11 - Select by Pin Count.BAS 2011/6/21 8:25 BAS 304 2KB

|12 - Move by Pin Count.BAS 2011/6/21 8:25 BAS 304 2KB

| 12 - Width Table.BAS 2011/6/21 8:25 BAS I 1KB
17 - Excel Part List Report '] [Ein Menu | 14 - Off-grid Pms.BAS. 2011/6/21 8:25 BAS I 2 KB
B0 - What s 2 Basic Serpt e -~ || 15 - Select All Test Paints BAS 2011/6/21 8:25 BAS 34 1KB
01 - Using a Message Box & [—];] || 16 - Part Web Search.bas 2011/6/21 8:25 BAS 34 2 KB T
02 - Using aVanable - Edit R R
03 )i Bt Faction E (27 - Excel Part List Report84s 2011/6/21 8:25 BasE# | 9 3Ke
04 - Using a PADS Layout Function i 18 - Excel Pin List Report.BAS 2011f6/21 8:25 BAS 3{F 3 KB
05 - Using If and Then Statements 1 ﬂ Load Fis = — 2 o
0 - Using & Custom Dialogl || 19 - Excel Via List Report.BAS 20117621 8:25 BAS 3 3 KB !
07 - Using a Custom Dialog2 _ q R 3
08 - Using a Custom Didlog3 || 20 - Excel Drill Report.BAS 2011/6/21 B:25 BAS 3 4 KB
09 - Using it &1l Tagether || 21 - Excel Drill Drawing.BAS 2011/6/21 8:25 BAS 3¢ 6 KB
1 o ord Hets <[ Close |1 22 - Excel Drill Drawing with Testpoin.. 2011/6/21 8:25  BAS ¢k 7 KD
Desaription || 23 - Create Assembly Labels.BAS 2011/6/21 8:25 BAS 3¢ 2 KB L4
C:\PADS ProjectshS ampleshS criptsiLayouth17 - Excel Part List Report bas L] 24 - DD Assembly Variant Check.BAS  2011/6/21 8:25 BAS Wi+ 34 KB

|| Alive Met List.BAS 2011/6/21 B:25 BAS & KB

|| BGA Die Report.bas 2011/6/21 B:25 BAS & KB

R A Fomnrt s b (0L Bla har N1 R RAC T AR L
(N . [Visual Basic Scripts (*.bas) v]
3 [[sme M| == |




9.3 i% & Basic Scripts T &

1. s PADS Layout Script Wizard—Run

[ FaDS Layout Script *izard - ] [ In Menu
10 - Lizt Of Comps and Hets - Bun

11 - Select by Pin Count
12 - Maove by Pin Count
13 - idth T able

17 - Excel Part Lizt Repart g
Alive Net List Load File..
BGA Die Report Unload File
BGA E:-c.pcurt Die to C5Y File L =

ek

L L kel ILLE = ]
PADS |ayaut 5ecripk *izard ek
Far feport =
. - Cloge
Drezcription

C:APADS ProjectshS ampleshScriptz\LapoutsPADS Layout Script ‘\Wizard baz

2. Mt Next

Welcome to the VB Script \Wizard.

Thiz program iz completely written in PADS Layout's WB zoript language. [t will
generate a skeleton VB zonpt for extracting databaze information in different
application farmats including BTF, Excel, and HTRL.

The “Wizard conziztz of a maximum of 3 steps. Al zettingz you have made will be
zaved in the Windows Reaistry, 20 you can alwaps remn the Wizard and then tune
zethings uzing a previous report az a previsw.

After completing thiz Wizard, pou can extend the resulting VB scrpt by manually
wiiting additional code.

Mo you can easily put vour colared HTML reparts an the camparny's [ntranet or
Internet sites to share them with pour colleagues or custamers!

WB Script Destination Directary

CAPADS ProjectshSampleshS crptzhLayout

[ Mext ] [ Caticel ]

3. %%+ Microsoft Excel, &4 i Next
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Choose the target application format for the new B scnpt.

R ezulting %B code will vary depending on pour choice.

(") Matepad Flain text format. Fited width font recommended.
[binirnurn formatting]

[ T wordPad /M5 Word  Rich test format.
[Better farmatting)
(o

(71 Intermet Browser HTHL farmat.
[Best autput quality, with colared tables)

Microsoft Excel Spreadshest.
[Eetter formatting with tables]

[ < Back ][ Mest » ] [ Cancel

4. 1%F¥% PCB-Based Reports J&, riili Next

Pleaze chooze which kind of report you want the new B zcnpt to generate:

cports

Reparts will contain databasze items collected from the entire design.
Azzembly Option will not be taken into account.

1 Azzembly Option Reparts

Fart and jurmper information will be extracted for each aszembly option
indivudually.

(71 Reparts for Given Assembly Option

B azedption

< Back [ Hest » ] [ Cancel

5. A Next



B e i S ===

Pleaze choose the type of database object that will be primary far the repart.

© Mets () Connection:
() Jumpers i) Ping (71 Boute Segments
! () Part Types ) Wias () Test Paints

[ Calculate the total number of primary objects in the design

< Back [ Mest » ] [ Cancel

6~ k4L riif Next

Y'ou have chozen Part az the primary twpe of databaze object for the WEB report. Mow
wou can chooge what data the new VB script will extract from a Part.

[ @ General Part properties in table Format

E ach row af the table representz an individual Part, and each column
represents a Part property, for example;

Attributes, Part Type, PCB Decal, Logic Family, Pin Count.

() List[z) of secondary objects related to each Part

For example: &ll Ping, Connected Ping, Unconnected Ping, Attributes

(77 List of Part objects anly

Edit List...

[ < Back Hest » ]I[ Cancel ]

7« AR BAVERmHINA, WBETEH#HIT Add f1 Remove, Up A1 Down SRXTiX
e = B 34T HEE . b Position X A1 Position Y Bt /2& 3411 55 E 4 1 1R AR bR S




Object Properties L i g

Add Part properties or attributes to the list of table columns.

T able Calurmis:

Part Type
Ilnconnected Pin Count << Remaove Layer Hame
W alle FCE Decal
Tolerance <¢ Bemowe Al | [|Fin Count
Glued [Tez/Ma] Layer Humber
ECO Reaqiztry [vesdMa] T Orientatian
P F'u:usitiu:un *
O Position v
SN | SmD [resmo)
[ Edit...

Attribute [Select exizting or type any walid name]:

-

< Back ][ Mext » ] [ Cancel

8. k4L il Next

Select additional report optionz for the YB scnpt.

Cutput Report Header ]
1

Header [ncludes: Jab M ame Date and Time Stamp

Show report generation progress in: Status Bar [ | Progress Bar
[] Enable Text Alignment far Table Columns

Cutput Index / T able of Contents [for HTML reports only]

—

[ < Back l Hest » ] Cancel

9. fii Finish&Run Report Now, B[R] % H AL bR SC4F




Cutput Files
Select the name of the repart file to which the new VB Script will extract information.

(7 Always bazed on job name [narme of the schematic file will be uzed]

(") Customn repart file name [ype without file extension): File Estenzion:
Fart Report wlz

@ Create new untitted document and pass data via Clipboard
Thiz option grays if pou chose WordPad or Internet Browser in step 2
[Recommended for Excel to avoid file share violations. ]

Enter the name of the rezulting WB zcnpt [without BAS extenzion]:
Fart Report -

[ < Back ][ Finizh ] [[ Finizh & Run Beport Mow ] |[ Cancel ]

10. BiT5Ebh LB ]G, A4 KILE Basic Scripts N, £ 1 Part Report i, Kk
g ALbR SO, i Run @47 RIAT

Fart Beport - ] [ In Menu
H - léislt EI[ Eu:ur;pséand rt\lets a Bun

- Select by Pin Coun
12 Yoo i Coun
,l.i_;'x;eE r::l;ntall_li::tnrt Lizt Fepart
B2 B0 CoV Pl
S e e b ]
P B e mermtCreripdvtimard
e [ Close |

Claze

Drezcription
C:APADS ProjectshS ampleshScriptesLapoutsFart Beport.bas

F=F R, EH T EIKEH PADS Layout #fF, BAT56A FB G, R IR
AARRSCAE, AR T

10. PADS #i it gerber 3014

PL1ANUEREES, 7 ) gerber FRR BTN EELE, $Ef4 PCB AR -
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BRI E=1EH i ‘
TOP TREELE: JEFE SRR, ¢ Beerberdi B H
BOTTO e

LATER? =

LAYERS =

Paste Mask Top ME#SE TFmEE

Paste Mask Bottom |[EERE T4 o] = 28

Solder Msak Top THERIE
Solder Msak Bottom |[EEFRIE

Sickscreen Top TE22ED S ENTE sl ckscreenE
Sickscreen Bottom  |[EEEZZED

Drill Drawing HILEE LEMES,

NC Drill HhfL AR 1L,

10.1 B ¥4 TAE

1. 75 gerber U2 B, FELS PCB Hif, B NAIE9E, Tools—Pour
Manger—Hatch—-Start.

ww Setup | Tools

1

\er Layer 2 'PCB Decal Eattor (1) Elo o Qe R B

Cluster Placement...

Help

Cluster Manager...
Disperse Components

Length Minimization Ctri=M = ]

Mudge Components ; Pour Manag)gy"m u
X

DxDesigner... 0 = | Flood Hatch ]Plane Connect]
Analysis

Hatch Mode
Manufacturing Z @) Hakch all

Fast Hakch @

EDMD Collaborator
PADS Router... @

Archive Mavigator /

Pour Manager...‘

Assembly Variants...
Update from Library...

Verify Design...
Compare Test Points...
DET Audit...
Compare/ECO...

5= | ECO Options...

Macros

Easic Scripts

Customize...

Options... Ctrl+<Enter>

WERPCBH H B T FIiiER:, TEM M I =20, mMEKE, 52
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— g oy =
I T # . ﬂ e — o = +.

2. Pour Manager m=n

= e e
Select Al = =

MllfeiE

= (D) ® =

p—
Confir nnect Operations

== skark [ Close ] [ Setup... ] [ Help ] i

2. FHZENGHE LS, File->CAM

File | Edit View 5Setup Tools Help
[ Mew Ctri+M
ﬁ Open... @ Ctrl+ O

IH save Ctrl=5
Save As..
Import...
Export...
Create PDF...

Archive...

Save as Start-up File...
Set Start-up File...

Library... @
Beports... /

CAM... =

CAM Plus..,

Print Setup...

3. DR 1 RIS A, IR 2 1 3 AISRIZT gerber it i H 3



Define CAM Documents S
CaM Documents
Cl
Document Mame: Fabrication Layer:
Edit...
Fy
o] o
Up
Dawn
Listing Fresview
CAM Question Iﬁ
E)
/ Enter CAM subdirectory name
F:haerbert
l (1] 4 ] l Cancel ]
X
Cakd Directorny: [<Ereate> - Aperture Repaort...

10.2 25 % 2 i

4 EHRIEH TOP. BOTTOM. LAYER2. LAYER3, 3t 4 N E.
i LI
HrpiE 8 Baf AT, BAENER LG TRE, AR RERH BN,

AR AR TRV R, W2 TOP, #’a)ik TOP, BOTTOM #HN [1)/4)i% BOTTOM,
WnE 2 LAYER2 MILAYER3, P #5A 75 B8] 1% .
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— - —_—

Define CAM Documents P

| Cam Documents @ . Cloze

Add Document @ P o
Save
Docurment Mame: —_— Edit \—I
TOF ok TR
Delete Help
Document Type: Output File: C |
ek Ty [ Cancel | T
| Routing/Splt Flane - | TOP.pho
D
Fabrication Ldyer: e . ~ lﬂl o
liail Layer Association [iE_J Import...
| Top : Fun P
Layer: Run ————————
Summany: @ | T | Evport..
op A - -
Routing#Split Plane: [Board |Set Layers... | Listing Froi
Top: (Pads Vias. Tracks.Cop TEvIE
QK ] | Cancel | | Help |
\ L%
@ |
Cusztomize Document Output Device
= 5 A
B Pl
Layerz | Options Frint Fen Photo
w,
‘ Presigwm ctions ‘ | Device Setup... ‘
Tip: Click Save Az Defaults to zave the current setlings as the Save Az Defaults
defaultz far thiz CAM dacument tppe and output device
= JAepart...

2L i S o Y R B A IR IR A T

k%

Cébd Nincyroent

2 1) Select Items - TOP

Layer Selections

Document Name: ———
Aailabl
o (T salble
Inner Laper 2

Add >
Document Tppe: Output File: Cancel Inner Laper 3 I——I |?|
- ——— Battam | <R | T el
Routing/Split Flane ~| TOP.pho Layer 5 Hemove

Fabrication Layer: Layer & Preview

Layer_7

Othes Items an Primary Help @
Summary:

i v
Routing/Split Plane: (Board. Outling Top) Set Lapers. . L e Ol n Pads Rel. Des.
Top: [Pads Vias Tracks Copper] Connections V| Traces Part Type

|TOD

Plated Slaot: 2D Lines Teut

Non-plated Slots V| Vias [ | Attributes

Customize Document Output Device /| Copper [ | Outlines

Component outlines
V| Top Mourted A [ | Keepouts Test Points

S g A X bt |||

Layers Optiong Print Pen Phota Padz Open Copper

| Color by Met Filled Copper

| Preview Selections | ‘ Device Setup...

Tip: Click Save As Defaults to save the curent settings as the Save &s Defaults

defaults for this CAM document twpe and output device

Selected Calor

10.3 B1/2E (Paste Mask) %!

SR :
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B 525, [ L& ZEmE—F, HP5E 2 PR cHSEM F EE KU Paste Mask,
BOTTOM #iI Paste Mask Bottom 3 241 & K= BT

ent Select Items - Select Trems -
Document Name Laper Selections Layer Selections
PASTEROT Awailable: BOTTOM [Tekce Ayailable: Selected:
Document Ty, Otput File: o a2 A1 [Lad ] W e Laper2 .‘ add>s || [Bot ‘
PASTEBOT.pho mzr'\:gyel 3 ILnanyeErLLgyev 3 | [ cchiemove |
Fabrication L ayer. Layei Layer 6 Paste Mask Bottom
[Paste Mask Bottom Laver? - Lojer.7 -
Summary: Other Help Other Items an Primam Help
Paste Mask: [Board Ouline Botm) Board Outine (] [C] Ref. Des. Board Oulline [ | [ | [ Reef. Des.
Egls‘;mM[asi B]nllnm (Pads) [~ Connections [T Traces [C]Pant Type [] Connections [C Traces [T Part Type
] Plated Slots [7] 2D Lines [ Test ] Plated Slats [T] 20 Lines [ Test
[7] Norvplated Slots [T vias [T Anributes [] Norvplated Siets [Cvias [T Attibutes
Fustomize Documert et || e B Coper [ 0utines Companent aulines ] Conper (01 Dutines
a5 [FTop Mourted ] Reepauts 7] Test Pairts 7] Tap Mounted [ Kespouts
i Iﬁl éﬂ, % BotiomMounted [l Pins with Associated Copper Bottom Mourted [l Fins with Associated Copper
dvanced Selection [ Advanced Selection
Lomo iz Pirt [ Pads ] Opsin Copper Fads Open Copper
C Color by Het [ Filed Copper Color by Net Filed Copper

Selected Color Selected Color
Tip: Click, Save As Defaults o save the curent

defaults for this CAM document type and oy

10.4 fH/EZE (Solder Mask) #iH

A 5 NP IRE B, REAERNE R

3 ent Select Items - SOLDERTOP. Select Items - SOLDERTOP
Dacumert Name: Layer Selections Layer Selections
SOLDERTOP Available: TOP [ Sekectes o Avsizble Selected
Document Typ Output Fie: Inner Layer 2 a et Layer 2 A | i
Inmer Layer 3 Selder Mask Toy nner Layer T —
Solder Mask. | x| soLoERTOR phe Eottor [ i Battom
- Layer 5 e Laper_5
Fabrication Layer: Laerp Laper 6 Solder Mask Top Freview
[ Solder Mask Tap Layer 7 2 Laer_7 =
Summay: Other Iteras on Primary Help Dther Items on Primary
Selder Mask: [Baard, Dutine Top) Ref.D Ret. D
Top (P TontBem] oard Dutline ] [ ] [F]Ref. Des. Board Outine (] [ | [7] Fiet. Des.
Solder Mask Tap: (Pads, Copper. T estPaints] [7] Connections [T Traces [C1Part Type [7] Connections [T Traces [ Part Type
[] Plated Slots [7]2D Lines [T Texnt [7] Plated Slots [T 20 Lines [Tent
[7] Non-plated Slats [F]vias [ Attributes [ Norvplated Slats [T Vias 7] Attrbutes
Custornize Document Dutput D
Component outines D ey D Q= Component outines S L L@ximee
=, op Mounted [l [T Keepauts [] Top Mounted (] [T Keepouts TestPoints Il
i ax’ % [7] Battom Mounted Pins with Associated Copper [ Bottom Mounted Pins with Assoiated Copper
Advanced Selection [] Advanced Selection
Lapers  Optians Fint
[T Pads [ Open Copper Pads Open Copper
l Preview Selections l l Color by Het [ Filed Copper Color by Net Filed Copper

et Selected Color
Tip: Click Save &s Defauls to save the current st elested Lolor

defaults for this CAM document lype and outp

10.5 2 E1Z (Silkscreen) #jH

0T 5 AP IRE L, REAERNERIT:

ent Select Items - SILKTOP T e | B select oms - s1LKTOP

Document Haie: Layer Selecions Layer Selestions

SILKTOP Avalzble Top [Seeced I Avalable Selected

Tozument Type Dutput il nner Laver 2 = Inner Laper 2 < [ aadrs | [T

SLKTOP gho Inner Layer 3 i 444 | Scscieen Top e Loy 3 ‘ [ agan i —
Bottorn e P ottom | | «cRemove
Laper_5 A Layer 5

Fabriation Laper

Layer 6 L Preview: taye[ﬁ i Silkscreen Top Preview
[sikscreen Tap Laer_7 ayer 7

Summary: Other ltems on Primary Help Other Items on Primary Help
?""Sﬁ[’;?ﬂ‘ [BT“'U”“‘”E Tog) ™ [ Pads [ Ref. Des. Board Outline n [7]Pads [*]Ref. Des,
op: (Dutlines|
Sikscreen Top: (Copper Lines, Text Outiines) [7] Connections [T Traces [T Part Type [] Comnections [ Traces [C]Part Type
[] Plated Slots [7] 20 Lines [ Test [] Plated Slots | n
|| Non-plated Slats [[vias [T Attributes [ Mon-plated Slats [7] Axttributes
Custorize Document COutput Des
———_— [] Copper Oullines - [ | Outlines
Fi ‘op Mounted (] [ Keepouts [ Test Points Top Mounted [ [T keepouts
i = % [] Bottom Maurted Pins with Associated Copper [] Bottom Mounted Fins vith Associated Copper
[7] Advanced Selection [7] Advanced Selection
Layers  Oplions Print
Pads Dpen Copper Pars Open Copper
[ Preview Selections ] [ Color by Net Filled Copper Color by Net Filled Capper

e Selected Caler
Tip: Click Save As Defaults to save the current sel elected Lolor

defaults for this CAM document type and outp
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10.6 &5 fLEE (Drill Drawing) %t

TEVER, A 4 SRS, RIESE 5 PR RIWAMESEL, RREILERSIER
R T H5314, Fiigerber XHF)5, H CAM350 v LAk &

e el koo QR ED B

Define CAM Documents

Drill Drawing Options

LR B A NG DL R -

Drill chart
- Draw chart
b | Letter height: Chart ling width: Location: @
Plot Options - drill drawing 14 3,048 0,254 X 100 ¥iog
Document Name:
drill drawing 14 Pasitioning
Diil Symbos.. || [1] | vl dats
Document Type: Output File: Orientation; Justification Crill symbal markers
Dirill Drawing ddi-4.pha 1} - Offset - ® E Tip: These are global settings. You cannot sek them per symbol.
Fabication Layer:  — Sealing . Offset Height{letter):  Line width: Height(symbol):
[SUnassgness 3 FE 100 - .27 0.25¢ 2,032 ] Shows ThroughyPartial column
[ Mirrar Image: ¥ Dffset
Summary: i -0,
e Miror Ref Ds 100 Dl size units Default tolerance: +/-0.0
Top: (Padaticg] Tip: Click Regenerate to automatically read dril data from the desian. Then sct the
Diill Dlawm’g: [Lines, Text) Other Options symbal and tolerance, Vou cannat change the size, quantity o plaked status,
Suppress Click Augment ko update an existing table with data fram the design.
Click Add Plated or Add NonPlated to manually add a new dril size.
Exclude Pads Symbol Size: Quantity  Plated Tolerance
Customize Document ® Output De:
FlotJob Name -
ﬁ % Plol indow ®
= i Flot OLE Objects
Layers | Options it Filled Lines/Pads
0
I Preview Selections ] { CAM Plane Layers
Generate CAM Plane Yia Themmals
Tip: Click Save Az Defaults to save the cument et Use Custom Thermal Settings
defaults for this CAM document type and autpl

Document Name:
dill daving 14

elect [tems - drill drawing 14

==

Select Items - drill drawing 14

==

Layer Selections
Available:

ToD | seiectes

Layer Selections

Preview

ectoy, | defadl

| Available: Selected
Output Fie: Inner Layer 2 ~ Inner Layer 2 = aads || [T
Inner Layer 3 Inner Layer 3 [Ladd» | T —
ddi-4.pha Battorm Botar <<Renove
Laper 5 e - 5
Fabrication Layer [ Loes I Drill Drawing
[ <Unassignec> Laper 7 hd Layer 7
Summary: Other Items on Primary Help Other Iters on Primary
[T’”” D[;;’VQ"% lE]nard] Board Dutline N Pads [ [7] Ref. Des. Board Oulline [l [[]Pads [C]Ref. Des.
op: [Pads Vias
Dl Drawing: [Lines.Text) [] Cornections [ Traces [ Part Type [7] Connections [ Traces [] Part Type:
[] Plated Slots [7]2D Lines [ Text 7] Plated Slots Dlines W Text ]
[ Norvplated Slots Wias [ | [ ttibutes [C] Mon-plated Slote [T ias [C] Anributes
Customizs Document Qulput De e iz
Companert outines [ Conper 1 0utines Component outines BlCere 8
7, [ Top Mounted [Tl Keepouts [C] Test Points [T Top Mounted [T Keepouts
ﬁ e S [ Bottom Mounted Pins with Associated Copper [ Botton Mounted Pins with Aszociated Copper
[] Advanced Selection [] Advanced Selection
Layers  Options Print
Pads DOpen Copper Pads Open Copper
l Preview Selections l l Color by Net Filedd Copper Color by Net Filled Copper
Selected Calor Selected Color
Tip: Click Save s Defaults to save the current st
detaults for this CAM document type and outp

10.7 85 fL1E

S 45l gerber 15 B AT,
FL. 14 385, TWETH 4%,

B (NCDril) % H

FE Y E Drill Pairs, PCB fi3t45 12 4L, 23 L. 34
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i File Edit View ﬁetui’ Tools  Help ai] Drill Pairs Setup -
HPE Pad Stacks... |
(2 || nnep LgEe Diill Pairs List &)
g m e a| Drill Pairs... - |
- Jumpers.. \ # Starting Layer # Ending Layer " ol
— 1 Top 2 Inmer Layer 2
Project Integration... 2 Irwer Layer 2 3 Irmer Layer 3 @ T
) Help
BA' Design Rules... 3| Inner Layer 3 4 | Bottom
Set Crigin

Display Colors..  Ctri+Alt-C I
1 default

2 monochrome

Add

Delete
Edit

N T A LS B IR

‘Ry

HpFEER, §=

Vias, 12 fL. 23 FL#1 34 LN Partial Vias.

;J/':EP, 14 ?L%@?L’ E&yﬂ Through

Define CAM Documents

i

ﬁ Edit Document

Document W arne:

%

Add

[ Clese |
Save

Close

Fabrication Layer:

[

DRILLT-2 Edit...
Diocument Type: Output File: | Carcel | Delete | | Help
NC Diill ~ | DRILL1-2.dil T

bilcley ﬁ NC Drill Options

|<Unassigned>

Run Output Pozition

Summary:

Ratation: [0 -

HEC Dill: (Plated Ping Mon-Plated Ping]
Fattial viaz: Top - Inner Layer 2

Customize Documett

=

Output Device

@

Optiohs

i

Set Layers

Qrigin Offzet:

Mirror Image

Hales
Through Yiaz
| Partial Vias

Cirill Pair:

Corill

‘ Preview Selections Device Setup...

1-2 A

Step and Repeat

o
-~

Caount:
w0
Distance:
w0
Yoo 0

Y. 0

f

Cancel

'

Help

/| Generate Listing
| Plated Finz

| Non-Plated Pins

®

Test Poirts

defaults for this CaM document type and output device

Tip: Click Save As_ Defaults to zave the current zettings a3 the Save As Defaults ‘

Cabd Directony: | default

Aperture Report... |

R
HME B2 IEM,
CAM350 #1467 gerber S

LE At A XA LT R AR N 2 1!

ﬁﬂ‘ﬁfnahﬂj/l\}%}?l’ﬂ gerber M2 /T, #BATUME FH Preview ATl

1A
T,

i

T HOHER. SHEEN gerber X2 5, A LAEH
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